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IBM Aspera Connect User Guide for Linux

Welcome to the Connect documentation, where you can find information about how to install, maintain,

and use Connect.

Introduction

IBM Aspera Connect is an install-on-demand application that facilitates high-speed uploads and
downloads with an Aspera transfer server.

Connect is compatible with most standard Web browsers. It integrates all of Aspera's high-performance
transport technology in a small, easy-to-use package that provides unequaled control over transfer
parameters. Connect includes the following features:

Feature

Description

FASP file transport

High-performance transport technology.

Browser interface

Uploads and downloads are launched transparently by a Web browser.

File syncing

Background synchronization of files.

Flexible transfer types

Easily transfer single files, multiple files, or entire directories.

Transfer retry and
resume

Automatically retries and resumes partial and failed transfers.

Browser-independent
transfer

The Web browser can be closed once transfer operations have begun.

Transfer monitor

A built-in transfer monitor for visual rate control and monitoring.

HTTP fallback

HTTP fallback mode for highly restrictive network environments.

Proxy support

HTTP fallback and FASP proxy settings.

Content protection

Password-protect files that are being transferred and stored on the remote
server.

Queuing

Allow a fixed number of concurrent transfers, and place the rest in a queue.

When you give Connect access to the IBM Aspera on Cloud Saa$ platform, you can perform the following

tasks:

« Transfer files and packages from within the same browser view.

« Synchronize local folders with folders on the transfer server, in both directions.

Note: You cannot synchronize with an Aspera on Cloud folder if it resides on an AoCts (Aspera on Cloud
transfer service) node. For AoCts nodes, sync is not supported.

When you give Connect access to an IBM Aspera Faspex transfer server, you can perform the following

tasks:

« Send packages to Faspex users and workgroups.

- Automatically download packages as they are received.

When you give Connect access to an IBM Aspera Shares transfer server, you can perform the following

tasks:

« Transfer files and folders to and from the transfer server.

« Synchronize local folders with folders on the transfer server, in both directions.
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Drag-and-Drop Support

The drag-and-drop feature is not supported on Linux systems in this release of Connect.

Setting up Connect

Installation

The procedure for installing IBM Aspera Connect requires enabling a browser extension for Connect in
addition to installing the Connect application itself.

There are two ways to install Connect on your system:

« Guided Installation: The most common way of installing Connect. If Connect is not installed or needs
upgrading when you try to upload or download files from an Aspera web app, such as Aspera Faspex or
Aspera Shares, you are prompted to install Connect and guided through the process.

« Manual Installation: For system-wide (multi-user) installations, and a fallback method for users with
non-typical web apps. You first install the Connect web extension for your browser. You then install the
Connect application by running a desktop installer you download from the Aspera website.

System Requirements: For information on supported operating systems and browsers, see the release
notes for this version of IBM Aspera Connect.

Before You Begin
Ensure that your Linux environment includes the following libraries:

« OpenSSL version 1.0.2g or higher (see below)

« Mesa EGL (If you get a launch error about libEGL, see below.)

- glib2 version 2.28 or higher.

The absence of up-to-date versions of these libraries could prevent Connect from launching.

Note: Connect does not support the Wayland compositor in this release. Some new distributions of Linux
are switching to Wayland. If this is the case for your distribution, you can work around it by switching to
Xorg mode.

OpenSSL

Depending on your Linux distribution and version, you may need to update your OpenSSL installation in
order to allow Connect to launch. The required minimum version of OpenSSL is 1.0.28. To determine
which version of OpenSSL is installed on your machine, run the following:

$ openssl version

For information on how to download and install the latest version of OpenSSL, see the KB article
Upgrading OpenSSL on Linux for Connect 3.7.x.

Mesa EGL

Connect requires Mesa EGL to be installed on your machine. If you are unable to launch Connect, and you
encounter an error about libEGL, it generally means the Mesa EGL package is not installed. To confirm
this, run the following:

$ 1dd ~/.aspera/connect/plugins/platforms/libgxch.so
If you then see the following, you need to install the Mesa EGL libraries on your machine:

1ibEGL.so.1 => not found
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To install the Mesa EGL libraries on Debian (for example), run the following:
$ sudo apt-get install libegll-mesa

Then reboot your machine.

For other Linux OSs, run the equivalent command.

Guided Installation

If you do not have Connect installed and you attempt to transfer packages or files using an Aspera web
application (such as Faspex or Shares), the Connect Welcome screen appears and prompts you to install
Connect:

Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.10.0.

Miw
Step 1 E_—;ZJ%L, ‘ Install Extension
Step 2 \|,

Already installed? Refresh / Troubleshoot

Depending on your browser/platform combination, the screens shown in these instructions may vary.
1. To begin, click Install Extension.

Your browser's page for the Connect extension opens. See the instructions for your browser in “Adding
the Connect Browser Extension” on page 4 to install the Connect extension. If successful, you'll see
the message confirming the extension has been added.

2. The welcome screen now prompts you to install the Connect application:
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Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.10.0.

New Iy S T
Q swep1r [ES
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ez (1] (I

Already installed? Refresh [ Troubleshoot

When you click Install Connect the installer image is downloaded to your Downloads directory. Once
downloaded, close your Web browser and run the following commands in the installer's directory,
replacing version+platform with the equivalent from the filename of the installer you just downloaded:

$ tar -zxvf ibm-aspera-connect-version+platform.tar.gz
$ ./ibm-aspera-connect-version+platform.sh

Note: The Connect installation script must not be run by user root. Connect on Linux may only be
installed per user, as opposed to system wide. To avoid errors, install Connect per user, excluding user
root.

Manual Installation
Step 1. Install the Connect extension for your browser.

For instructions about obtaining the Connect extension for your browser, see “Adding the Connect
Browser Extension” on page 4.

Step 2. Download and run the Connect application installer.

You can download the tar. gz file containing the Connect installer for your Linux platform directly from
https://www.ibm.com/aspera/connect/. Once downloaded, close your Web browser and run the following
commands in the installer's directory, replacing version+platform with the equivalent from the filename of
the installer you just downloaded:

$ tar -zxvf ibm-aspera-connect-version+platform.tar.gz
$ ./ibm-aspera-connect-version+platform.sh

Note: The Connect installation script must not be run by user root. Connect on Linux may only be installed
per user, as opposed to system wide. To avoid errors, install Connect per user, excluding user root.

Adding the Connect Browser Extension

For supported web browsers, this section explains how to obtain and add the IBM Aspera Connect
extension to the browser you will use. The Connect extensions are specific to the browser; the procedure
for adding an extension to a browser is the same regardless of which OS platform that browser is running
on. With a guided install, clicking Install Extension opens the extension link for the browser you are
using. With a manual install, be sure to download the extension for the browser you intend to use with
Connect.
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Chrome
To obtain and install the Connect extension for Chrome, follow the procedure below:

1. Click Install Extension (guided install method), or open the IBM Aspera Connect page on the Chrome
Web Store (manual install method). The following page opens:

&~ chrome web store e s

G IBM Aspera Connect

Offered by: IBM Aspera

W % W % 1 | Productivity | & 2é41users

Qverview Reviews Related

2. Click Add to Chrome. The Add "IBM Aspera Connect"? popup appears.
3. Click Add extension.

@_J Add "IBM Aspera Connect”?

It can:
Read and change all your data on the websites you visit

Communicate with cooperating native applications

e D

If successful, you'll see the message "IBM Aspera Connect has been added to Chrome".

Note: The extension is activated only by websites that have integrated IBM Aspera for file transfers. The
extension never reads or stores any personal information or history.

Incognito Mode: By default, the Connect extension is disabled in Chrome's incognito mode. To enable
the Connect extension, right-click the small Connect icon in the upper-right corner of your browser page.
Then open Manage extensions and scroll down to the heading Allow in incognito. Then set the switch to
ON as shown below.

Allow in incognito
Warning: Google Chrome cannot prevent extensions from recording your browsing history. To disable .

this extension in incognito mode, unselect this option.

Firefox
To obtain and install the Connect extension for Firefox follow the procedure below:

1. Click Add extension (guided install method), or open the IBM Aspera Connect page on the Firefox
Add-Ons page (manual install method). The following page opens:
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Extensions

IBM Aspera Connect
by IBM Aspera

This add-on enables the use of IBM Aspera Connect with Firefox. This add-on
requires the IBM Aspera Connect application, version 3.9.0 or newer. + Add to Firefox
IMPORTANT: If you encounter an error "Download failed. Please ‘h

check your connection”, update Firefox.

2. Click + Add to Firefox. The Add IBM Aspera Connect? popup appears.
1
;i.. & Mozilla Foundation (US) | https://addons.mozilla.or
G Add IBM Aspera Connect?
¥ It requires your permission to:

& fAccess your data for all websites
& Exchange messages with programs other than Firefox
& Access browser tabs

“ QEHCEI

3. Click Add.

If successful, you'll see the message "IBM Aspera Connect has been added to Firefox".

After Installation

Once Connect has finished installing, it will execute automatically when you access a Connect, Faspex, or
IBM Aspera Shares web page. Look for the Connect icon in your menu bar to confirm that it's running.

If Connect does not start automatically (or if you need to restart it), you can execute the application
manually with the following command:

$ ~/.aspera/connect/bin/asperaconnect

Tip: Aspera provides a web-based diagnostic tool that can be helpful in identifying connection issues.
You can access the IBM Aspera Connect Diagnostic Tool here:

https://test-connect.asperasoft.com/
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Network environment

Connect typically requires some configuration steps in order to function in your network environment.
Configuration settings also allow you to limit transfer rates and use an HTTP proxy.

Network Requirements

Your SSH outbound connection may differ based on your organization's network practices. Although
TCP/33001 is the default setting, consult your IT department for questions related to which SSH ports
are open for file transfer. Also see the help documentation for your particular operating system, for
specific instructions on configuring your firewall. If your client host is behind a firewall that does not allow
outbound connections, you will need to allow the following:

« Outbound connections for SSH, which is TCP/33001 by default, although the server side may run SSH
on another port. Check with your IT department for which SSH ports are open for file transfers.

« Outbound connections for FASP transfers, which is UDP/33001 by default, although the server side may
run FASP transfers on one or more other ports. Check with your IT department for which SSH ports are
open for FASP transfers.

HTTP and FASP Proxies

If you need to configure any network proxies or override network speeds, you can do so through the
Connect Network option. For information on configuring proxies, see “Network configuration” on page
37.

Limit transfer rates

You can limit the bandwidth that Connect uses. For example, your office may have limited bandwidth to
share among its users.

Important: For the SaaS products Files and Aspera on Cloud, use this field to set the default transfer
speed.

You can limit Connect transfer rates by launching the Connect Preferences dialog and go to the
Bandwidth tab.

Preferences - IBM Aspera Connect AE 0

2 General it Transfers 4 Network 4 Bandwidth 1 Security

Transfer speeds depend on server settings and your network connectivity. The settings
below allow you to limit transfer rates.

Download

| Limit to: |100 Mbps ~
Upload

| Limit to: |100 | Kbps

=

You can limit the download and upload transfer rates by selecting the respective check-boxes and
entering a rate in either Mbps or Kbps. Setting a maximum speed doesn't guarantee your transfers
achieve that speed. Actual performance depends on the following factors:

IBM Aspera Connect User Guide for Linux 7



« Your network's bandwidth: Available bandwidth on your network may limit your transfer rate, even if you
enter larger numbers into these fields.

« Your Aspera server transfer settings: Settings on your server may limit your transfer rate even if your
network bandwidth and the numbers you enter are larger.

For more information on bandwidth configuration settings, see “Bandwidth configuration” on page 38.

Transferring files with Connect

Initiating a transfer

You can use Connect with the Aspera demo server to test basic transfer functionality and also familiarize
yourself with how to initiate uploads and downloads.

The steps below describe how to initiate a file transfer, and shows how to perform a download from
Aspera's demo server.

Important: In order for Connect to function correctly, your browser must have cookies enabled. For
instructions on verifying this setting, see the help documentation for your browser.

1. Open your web browser and log in to Aspera's demo transfer server at https://aspera.pub/600tzmU.
2. 0On the AoC Demo page, open the folder small.

To select a file or folder you want to download, click the check-box next to it. You can also click
multiple boxes to select more than one file or folder to download at a time. Once you've made your
selections, click the Download button.

Demo
More « 1item selected Cancel
N\
Name ~ Size & Lastupdated @
Mar 13, 2020
1 [® nettoxt 128 el
11 GB -
] m large ol
50 MB -
v )
M [ smau o
. 1,000 KB —
tin !
D I:] "y 5 files

3. Confirm the download.

A dialog appears asking whether you want to allow the server access to your machine. Select Yes to
begin. To skip this dialog in the future, enable the check-box Remember my choice for this site. The
server is then added to your Trusted Hosts list. For more information on trusted hosts and how to
manage them, see “Security configuration” on page 38.

The way hosts are granted access differs from previous Connect releases. Instead of prompting for
permission to communicate with a transfer node when a transfer is about to start, Connect prompts

for the website when the website first tries to interact with the Connect APIs. Thus, the address in the
dialog is no longer a transfer server, but is instead the address of the website. As a result, sites that
perform transfers with many different hosts no longer need to respond to access requests from each of
those hosts, because there will be only a single request for the web site.
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IBM Aspera Connect - Security Warning®

Allow access to your computer?

.2 This site is requesting permission to upload and
download files to and from your computer.

cs-int.asperademo.com

Remember my choice for this site.

Yes No |

Once you confirm that the configuration settings are correct and that Connect is working properly, you can
begin transferring with your organization's Aspera server. To get started, simply point your browser to your
server's host name.

Note: The URL format of the address can be different, depending on your server product.

Multi-session transfers

Data can be transferred faster by using multiple-session transfers (also known as parallel transfers and
multi-part transfers) to and from multi-node servers and clusters, on premises, or in the cloud.

If a transfer meets the criteria that you configure in the Connect Preferences dialog, files are
automatically transferred with multiple sessions.

Configuring multi-session transfers

Launch the Connect Preferences dialog and go to the Transfers tab.

IBM Aspera Connect User Guide for Linux 9



Preferences - IBM Aspera Connect - 0O X
General S+ Accounts £ Transfers #h Network ©» Bandwidth 1 Security

Downloads

®) Save downloaded files to:
/homefaspera/Downloads Browse

Always ask me where to save downloaded files.

Queue
v| Enable queuing

Maximum concurrent transfers: |3

Retry
V| Automatically retry failed transfers
Attempts: |3 time(s)
Interval: |30 seconds -

The interval specifies an amount of time that will elapse between each attempt to restart a
failed transfer.

Multi-session

v Enable multi-session

Number of sessions: 3

When transferring faster than: 700 Mbps v

v Split files larger than: 60 MB -

Start interval between sessions: |1 seconds -

Sync
Interval: |30 seconds =
v’“'npply @ cancel & oK

Field Description Default Setting
Enable multi-session Enable multi-session transfers. Unselected
Number of sessions The number of sessions you 3

prefer (as guidance, not as a
requirement).

When transferring faster than The transfer speed that triggers | 700 Mbps
multi-session transfers.

Split files larger than Enable file splitting for files larger | 60 MB
than or equal to the specified
size. This value is sometimes also
referred to as the multi-session
threshold.
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Field Description Default Setting

For example, using the default
size value (60 MB), if the source
directory contains multiple files,
all files less than 60 MB are
distributed between sessions,
while all files 60 MB or larger
are split and then distributed
between sessions. If the source
directory contains only one file
and the file is 60 MB or larger, the
file is split, otherwise the file is
transferred by one session.

Startup interval between The amount of time to wait 1 second
sessions before the next session starts.
Limitations

« Encryption-at-Rest (EAR): Files cannot be split when EAR is used. If EAR is specified, splitting is
disabled.

- Resuming transfers: When file splitting is enabled, the ascp resume-transfer option is set to =k 0
(always transfer the entire file again). Recommended: If you need the ability to resume transfers,
disable file splitting.

« HTTP Fallback: HTTP fallback cannot be used with multi-session transfers. If specified, HTTP fallback
is ignored.

« Single-file transfers without splitting: A multi-session transfer of a single file without file splitting
potentially results in a slower transfer. The target rate for each session is 1/N of the total target rate.
If a file is not split, only one session does productive work. This might not be an actual limitation if the
single session is already taking advantage of all available bandwidth; for example, if the same transfer
rate was obtained by a single session transferring at maximum speed.

Recommended Practices

« When to use multi-session: Enable multi-session only when:
— You have a fast network connection (>1 Gbps).
— The server has a slower network connection than your network connection (cloud virtual machines).
— Additional servers are available to handle additional traffic (cluster of servers).

« Startup Interval: If you have a large transfer that would require the transfer cluster to scale to meet
the demand, set a higher startup interval to allow additional virtual machines to come online. It can take
5-15 minutes for new instances to become available.
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The Activity window

Right-click G and select Activity to open the Activity window, where you can view and manage all transfer
sessions. From here you can stop a transfer, resume it, retry a failed transfer, and open the location
containing the content.

Activity - IBM Aspera Connect - O X

& Transfers | & Sync %, Inboxes

1407929019 14383 1000k.split.13.md4s

CRONO)
Done
10MB.7
fhomefaspera/Downloads/10MB.7
[ (CXGNO]

Downloading 6.4 f 10.0 MB ....32 Mbps) - 0:02 remaining 0:04 elapsed

Clear list

The Activity window contains the following controls:

- @ Open the Transfer Monitor. For more information on this feature, see Monitoring Transfers.

- @ Open the folder on your computer that contains this content.
O, Stop the transfer.
« ® Resume a stopped transfer, or retry a failed transfer.

When the queuing option is enabled, the number of concurrent transfers is limited. The additional
transfers are queued in the Activity window and initiated when a transfer is finished. You can manually

start a queued transfer by clicking the & button. You can also right-click on a started or stopped transfer
to access various controls. The example below shows the right-click options for a stopped transfer.
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Activity - IBM Aspera Connect - O x

£ Transfers | &) syne | Inboxes
1407929019 14383 1000k.split.13.m4s

®oo

Done

1407929019 236570557 _1000k.split.11.m4s (+2)

] Qe

Stopped
b Resume

Remave
Show in Transfer Monitor
Open containing folder

Go to "http:/{demo.asperasoft.com/asperajuser/7B=%2FUpload"”

Clear list

Clear list

Monitoring transfers

From the Transfer Monitor window, Connect lets you monitor transfer progress. The Transfer Monitor
provides a graphical interface to adjust file transfer speed, adjust the minimum transfer rate, and set rate
policy—all while the transfer is in progress.

To monitor a transfer session shown in the Activity window, click the & icon shown with the session. The
Transfer Monitor opens:
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Transfer Monitor x

IMG _4335.CR2
fhome/aspera/Downloads/IMG_4335.CR2

®e

Downloading 409.0 / 500.0 MB (49.54 Mbps) - 0:17 remaining 0:35 elapsed

100.00 Mbps

50.94 Mbps ¥

2

0 bps

Fair -

The following controls are available in this window:

- @ Open the folder on your computer that contains this content.
O, Stop the transfer.
- ® Resume a stopped transfer, or retry a failed transfer.

If you have sufficient server privileges and your transfer server is configured to allow it, you can adjust
or set your desired transfer rate, minimum transfer rate, and rate policy. However, actual performance is
subject to the available bandwidth on your network as well as the transfer settings on your server:

- Target transfer rate — To adjust the transfer rate, locate and select the upper slider © on the left side
of the graph and move it up or down to change the desired rate. Note that the actual rate depends on
several factors.

« Minimum transfer rate — To set the minimum transfer speed, locate and select the bottom slider (2]
on the left side of the graph and move it up or down to set the desired rate. The actual minimum rate
depends on several factors.

 Transfer policy — Select the transfer policy from the drop-down list at the bottom of the window. Note
that your specified rate policy may be subject to external limitations:

Fixed
The transfer transmits data at a rate equal to the target rate, although this may impact the
performance of other traffic present on the network.

High
The transfer rate is adjusted to use the available bandwidth up to the maximum rate.

Fair
The transfer attempts to transmit data at a rate equal to the target rate. If network conditions do not
permit that, it transfers at a rate lower than the target rate, but no less than the minimum rate.

Low
The transfer rate is less aggressive than Fair when sharing bandwidth with other network traffic.
When congestion occurs, the transfer rate is decreased to the minimum rate, until other traffic
retreats.
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- Additional options — Right-clicking in the area above the graph opens the same menu as doing so in
the Activity window, giving options such as stop or remove transfers, and open the transfer's containing
folder.

File encryption

Connect provides a means to protect files with Aspera encryption when the files are uploaded to a
content-protected server, and to decrypt those files when downloaded.

Whenever you upload files to a server configured as a content-protected host, Connect prompts you to
create a passphrase to protect the files with Aspera encryption. When you download those files, access
to the files' contents requires that you provide the passphrase to decrypt them. Files can be decrypted
during the download transfer, or decrypted after the download is complete. Files can be decrypted from
within Connect, or by using the utility IBM Aspera Crypt, which is included in the Connect installation.

Encrypting files
Servers to which you want to upload encrypted files must be enabled for content protection. For more
information, see the Content Protection section of Security Config.

When uploading files to a content-protected server, you are prompted for a passphrase to encrypt the
files. You can either enter the passphrase in the text field, or check Keep files unencrypted to proceed
without using this feature (if allowed by the server). To start the transfer, click OK.

Protected Content - IBM Aspera Connect @

i Enter a passphrase te store files in an encrypted
| *  format on the server. A passphrase is required.

Passphrase |sssses

Confirm sesese

oK Cancel

Once Aspera-encrypted files have been uploaded to your server, they can be identified by an additional
file extension, .aspera-env (Aspera Security Envelope).

@ Welcome asperaweb (change user)

=4 aspera connect server

demo.asperasoft.com
¢ Download ¢ Upload #Upload Folder g Delete o New Folder
Name Size Last Modified
g IMG_4333.CR2.aspera-env 18MB Apr 3, 2018 9:03:00 PM
g IMG_4336.CRZ.aspera-env 18MB Apr 2, 2018 4:15:03 PM
s L1OMB.3 10MB MNow 16, 2017 10:11:34 AM
g 14601890.gif.aspera-env 480B Mar 19, 2018 3:13:33 PM

Decrypting Files During Download

When you use Connect to download a content-protected file, a dialog opens prompting you for a
decryption passphrase:
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Protected Content - IBM Aspera Connect Protected Content - IBM Aspera Connec

(v Enter a passphrase to decrypt protected files as they i Enter a passphrase to decrypt protected files a
| are downloaded. | | ® aredownloaded.
Passphrase [sssee4| ] Passphrase

Keep files encrypted v | Keep files encrypted

|E|
-~
g
o
=
]
L
|E
-~
g
o
=

You have two options:

« Enter the passphrase. In this case, Connect decrypts the files during the download. When the files arrive
at their destination, they are no longer encrypted, and no further steps are necessary.

« Check the Keep files encrypted box. In this case, Connect transfers the files to the destination in the
encrypted state. You don't need to enter a passphrase (if you do, it is ignored). With this option, the files
retain the .aspera-env extension on your disk. You can decrypt the files any time after the download
has completed.

Note: If you choose to decrypt encrypted files during download, the transfer may fail if the password
you supply doesn't apply to all the encrypted files. In this case, retry downloading and check the box for
Keep files encrypted. You can then decrypt them after they are downloaded. See “Decrypting Files after
Download” on page 16 below.

To proceed with the download, click OK. The Connect Activity window appears and shows the progress of
the transfer. When finished, the progress bar disappears, indicating the files are now at their destination.

Decrypting Files after Download

To decrypt downloaded files you have chosen to keep encrypted, run the IBM Aspera Crypt utility. You can
launch Crypt using any of the following methods:

« From the Connect Activity window: Once the transfer is complete, the Connect Activity window displays
the link Unlock encrypted files:

Activity - IBM Aspera Connect x

IMG _4336.CR2.aspera-env

Decryption finished @ @ ®
Done

IMG_4333.CR2.aspera-env

Unlock encrypted files @ @ ®
Done

To launch Crypt, click Unlock encrypted files. This is the most convenient method for unlocking
protected files once they've been transferred. Depending on your preferences settings, you can also
decrypt your files from here later, as the transfer records remain in the Connect Activity window until
you remove them by clicking Clear List. However, the files remain only if under the Preferences >
General you chose to remove transfer list items Manually instead of automatically after transfer.

16 IBM Aspera Connect 4.1 User Guide for Linux



- By opening an Aspera-encrypted file: You can launch Crypt by opening an .aspera-env file from the
context menu or by double-clicking the file.

« From the Connect application menu: To open the application menu, click the Connect icon in the menu
bar. To launch Crypt, select Unlock encrypted files.

When you launch Crypt, the following window opens:

IBM Aspera Crypt x

File Options About

Open Files Open Folder Settings

Passphrase |[*+#++| . ] [ Decrypt

Show passphrase

| AL e s S s, L e -

If you launched Crypt from the Connect Activity window or by opening an aspera-env file, Crypt
decrypts the files that were selected. From the Crypt window, you can also select Open Files or Open
Folder and browse for files or folders to decrypt. When your encrypted contents are loaded into Crypt,
a status message appears at the bottom of the application, displaying the number of items ready for
decryption.

To unlock protected content, fill in the encryption passphrase and click Decrypt. The files are unlocked
and the results displayed in the window:

File Options About

Open Files Open Folder Settings

Passphrase |****** Decrypt

Show passphrase

Finished -= /home/aspera/Downloads/

IMG_4336.CR2.aspera-env 100.0% IMG_4336.CR2

The decrypted files are placed in the same directory as the original encrypted files:
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aspera@kbequa:~ dss 1s -1

total 748792

-TW-TW-r-- 1 aspera aspera 19827846 18:21 IMG_4333.CR2
-TWXrWXrwx 1 aspera aspera 19827966 :52 IMG_4333.CR2.aspera-env

-rw-rw-r-- 1 aspera aspera 19827846 :25 IMG 4333(decrypted).CR2
-rwWw-rw-r-- 1 aspera aspera 19834559 :58 IMG_4336.CR2

-TWXrwxrwx 1 aspera aspera 19834679 :51 IMG_4336.CR2.aspera-env
-rwWw-rw-r-- 1 aspera aspera 19834559 :26 IMG 4336(decrypted).CR2

If you choose to decrypt a file and there is already an unencrypted file of the same name in that folder,
the newly decrypted version appears in the Crypt window and the folder listing with "(decrypted)" added
to the filename, as in the above example. However, note that if you decrypt the file yet again, the
"(decrypted)" file is overwritten without notice.

Maintaining Your Connect Installation

Upgrading Connect
When a new version becomes available, Connect prompts you to confirm whether to upgrade.

Note: Before upgrading, ensure that you have no previous Connect installations on your system — either
single-user or system-wide.

To download the latest version of Connect, go to https://www.ibm.com/aspera/connect/. Click Download
Now and follow the on-screen instructions. This downloads the latest installer.

You are also prompted to upgrade you attempt a download and Connect is not found or otherwise unable
to launch:

Required Steps

To enable Aspera uploads and downloads, you need to install
or upgrade to IBM Aspera Connect 3.10.0.

Mew T S
Step 1 E’)‘%Ui, Install Extension
Step 2 _$

Already installed? Refresh | Troubleshoot

If Connect is not installed, or is out of date, you can download it from here by clicking Download latest
version. If Connect is already installed, you can click Troubleshoot to open the IBM Aspera Connect
Diagnostic Tool. You can also access the tool here:

https://test-connect.asperasoft.com/

Connect and Aspera Drive
Note: Connect 4.0 and later include all Drive features and is the official upgrade path for Aspera Drive.

If you have IBM Aspera Drive installed, Connect prompts you to migrate your Drive settings to Connect. If
you accept, Connect migrates Drive settings and then prompts you to uninstall Drive.
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Uninstalling

The Connect installation provides scripts for uninstalling Connect.

Uninstalling the Connect Application
Important: You must quit Connect before uninstalling it.

After you have quit the Connect application, run the following script to uninstall it:

$ ~/.aspera/connect/var/uninstall.sh
Uninstall finished.

Removing the Connect Browser Extension
For Chrome and Firefox, the browser extension is removed separately, as described below.
Chrome

To remove the extension from Chrome, click the three-dot icon in the upper right corner of the Chrome
window.

Note: In certain circumstances, the default three-dot icon may not be visible while displaced by other
icons. For example, a circular yellow/orange icon with an arrow indicates Chrome needs to be updated.

In the drop-down menu that opens, choose More Tools > Extensions:

New Tab #T
New Window #N I
New Incognito Window O¥EN
History >
Downloads XL
Bookmarks 4
Zoom - 100% + "o
Print... #P
Cast...
Find... 3*F
More Tools 4 Save Page As... #S
Edit Cut Copy Paste
Settings % Clear Browsing Data... oG
Help » Extensions
Task Manager k
Developer Tools &

The Extensions tab opens. Look for the panel with the Connect extension and click Remove:
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% Extensions b4 +

® Chrome | chrome://extensions

IBM Aspera Connect
@i Enable high-speed FASP transfers.

Details Remove &

W

The Connect extension is now removed from Chrome.
Firefox

To remove the Connect extension for Firefox, open the three-bar icon in the upper right corner of the
browser window, and click Add-ons:

v IN D & =

& Signin to Sync

© Content Blocking Standard

E} New Window 3N

©9 New Private Window 0 ¥P
Zoom - (100% =+
Edit ¥ B @

I\ Library >

=0 Logins and Passwords

2§ Add-ons O %A

-ﬁ- Preferences 3,

,/ Customize...

The Add-ons Manager tab opens. Look for the panel with the Connect extension and click Remove:
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<« c @ Firefox  about:addons w ¥ In D & =
Find more extensions | Q. Search addons.mozilla.org
+ :
&> Get Add-ons Manage Your Extensions I v
*‘ Extensions (@ Firefox is changing how extensions work in private browsing. Any new extensions you add
to Firefox won't run by default in Private Windows. Unless you allow it in settings, the
Z Themes extension won't work while private browsing, and won't have access to your online
»

activities there. We've made this change to keep your private browsing private.
e Learn how to manage extension settings
B Plugins

O IBM Aspera Connect Disabla
*  Enable high-speed FASP transfers.

Remove

I+ Firefox Preferences

@ Add-ons Support

The Connect extension is now removed from Firefox.

Working with IBM Aspera High-Speed Transfer Server

Adding an High-Speed Transfer Server account to Connect

IBM Aspera High-Speed Transfer Server (HSTS) is the foundation under Connect transfers with Faspex
and Shares, and under Connect transfers with AoC if your AoC uses an on-premises (tethered) transfer
node. Therefore, in any of these cases, the configuration of your HSTS is fundamental to your Connect
implementation.

For the most part, your HSTS does not need special configuration in order to work with Connect. You
configure your HSTS for use with Connect in the same way as you would for use with Aspera on Cloud,
Aspera Faspex, or Aspera Shares.

Setting Group Ownership

In some cases, you may want to control the permissions on files that are uploaded to a transfer server. To
do this, you can set the SGID bit on the directory on the transfer server into which files are transferred.

The steps below set the SGID bit on a directory named limited. When the steps are complete, transfers to
the limited directory will have group ownership rather than user ownership.

Note: The change in ownership applies to Connect transfers to this directory, and to files created in this
directory on the transfer server itself, but does not apply to transfers performed through sync actions.

1. Set the transfer server to ignore group ownership.
asconfigurator -x "set_node_data;group_ownership,-"

2. Change the group associated with the limited directory to mygroup. The group named mygroup is not
the user xfer's primary group.

chgrp -R mygroup limited/
3. Set the SGID bit for the destination directory limited.

chmod -R ug=rwx limited/
chmod -R g+s limited/
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4. Verify your changes.

1s -la limited/
drwxrwsr-x 1 root mygroup 1234 Apr 23 10:42 .

Your output may vary, but ensure that the s is present in the group's permissions.

Working with IBM Aspera on Cloud

You can use Connect in conjunction with IBM Aspera on Cloud, a SaaS platform for file transfer and
collaboration.

When Aspera on Cloud is integrated into Connect, you can do the following:

« Share content with members of your organization.
« Send packages to an Aspera on Cloud inbox.

Note: Connect does not currently support adding metadata to packages when sending to a user, but you
can send metadata to an Aspera on Cloud inbox.

For detailed information on using Aspera on Cloud, see the Help Center within the Aspera on Cloud
application.

Adding an Aspera on Cloud account to Connect

Use the Connect account wizard to configure a new AoC transfer account.
Have the following information available before configuring an account:
 Your organization name in Aspera on Cloud.
« The username and password that you have on Aspera on Cloud.
The steps below assume that you have Connect installed and running.
To add an Aspera on Cloud account to Connect:

1. Launch the Connect Preferences dialog and go to the Accounts tab.

2. Click [+] to add a Connect account.

3. Select your IBM Aspera product:

Click IBM Aspera on Cloud.
4. Select your organization:

In Aspera on Cloud, the organization is the primary administrative container.
Either

» Enter your IBMid or email address, so that Connect can find your organization for you.

or

 Enter your organization URL.
5. In the new window that opens, sign in to Aspera on Cloud.
6. Set up content synchronization:

On the Sync Setup screen, either

 Set up syncing now.

To do so, either accept the default folder shown for Place my files in, or click Change to browse for
a different folder (or create a new one).

By default, the sync folder is created inside your Documents folder, in a folder with the name
you gave for the account in an earlier step. If you choose to use the default folder, it is created
automatically.

 Set up syncing later.
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To do so, click I'd rather not set up file syncing now.

7. If you opted to set up syncing on the previous screen, the Account Wizard prompts you to choose
folders to sync.

You can either

« Select Synchronize with the selected remote folders and then select the folders on Aspera on
Cloud to sync.

Click the arrows to expand or collapse the folder view, and select the check boxes for the folders
you want to sync.

Choose the sync direction:

- Two-Way

— Remote to Local (default)
— Local to Remote

Note: For a detailed explanation of your options for sync direction, see “Synchronization” on
page 29.
» Select I'll choose the folders to sync later.
8. Set up package downloading:

« Choose Automatically download my packages to and enter or browse to a location where you'd
like to store your downloaded packages.

e Choose I'd rather not set up automatic downloading now. You can change this setting later if
you wish.

9. If you opted to set up package downloading in the previous step, now select a time-frame:
« Choose to download packages from a date in the past.

Select Download my packages from date sent and choose an option from the drop-down:

Yesterday (default)

A week ago

A month ago
The beginning of time

« Choose to download packages from now on.
10. Set up how you will check for new packages:

« Automatically

Select Check for new packages and select an automated time interval from the drop-down list.
- Manually

Select I'll check manually using the Check Now option.
11. Click Finish to complete your Aspera on Cloud account setup.

Working with IBM Aspera Faspex

When working with Faspex, you can send and receive files and folders as packages.

IBM Aspera Faspex is a file-exchange application built on IBM Aspera High-Speed Transfer Server as a
centralized transfer solution. With a Web-based GUI, Faspex offers advanced management options for
FASP high-speed transfer to match your organization's workflow.

Before configuring Faspex to work with Connect, you need the following;:

- A computer running the correct version of Faspex. For instructions on how to install Faspex, see the IBM
Aspera Faspex documentation.
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« Credentials for a Faspex user account. You need one of these accounts to provide Connect access to
Faspex.

Adding a Faspex account to Connect

Use the Connect account wizard to configure a new package transfer account.

Have the following information available before configuring an account:

« The address of the server where Faspex is installed and running.

« The username and password that you have on the Faspex server.

The steps below assume that you have Connect installed and running.

To add a Faspex account to Connect, do the following:

1. Launch the Connect Preferences dialog and go to the Accounts tab.

10.

. Click [+] to add a Connect account.
. Select your IBM Aspera product:

Click IBM Aspera Faspex.

. Fillin the fields with the following information about the Faspex transfer server:
Account name A name for the account. The name is used only by Connect.
Server address The URL for the server that is running Faspex.

Click Next.

. Select your Faspex server's authentication method:

« SAML Authentication: Log in to the Faspex server with this user's SAML credentials.
- Basic Authentication: Enter the username and password of the Faspex user.

. If you are prompted to confirm the server's security certificate, indicate whether you trust the server.
. Set up package downloading:

« Automatically download my packages to the following directory and enter or browse to a
location where you'd like to store your downloaded Faspex packages.

- I'd rather not set up automatic downloading now. You can change this setting later if you wish.

. If you opted to set up package downloading in the previous step, now select a time frame:

« Choose to download packages from a date in the past.

Select Download my packages from date sent and choose an option from the drop-down:

Yesterday (default)

A week ago

A month ago
The beginning of time
« Choose to download packages from now on.

Click Next.

. Set up how you will check for new packages:

- Automatically: Select Check for new packages and select an automated time interval from the
drop-down list.

« Manually: Select I'll check manually using the Check Now option.
Click Finish to complete your Faspex account setup.
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Modifying your package download settings

You can modify the following aspects of a package transfer account:

« The local destination folder for downloading received packages.

« How often Connect should look for new packages.

- Whether to overwrite packages that have the same title.

« Whether to automatically decrypt downloaded packages.

The steps below assume that you have Connect installed and running, and that you have created at least
one Connect account that you want to modify.

1. Launch the Connect Preferences dialog and go to the Accounts tab.

2. On the left side of the dialog, select the transfer server account you want to modify.
3. Under Account, you can change the connection settings for the account:

Field Description

Account name The name of the account. The name is used only by Connect.
Server address The URL for the server, and the port number (if applicable).
Username The username that you have on the transfer server.
Password The password that you have on the transfer server.

Do not verify host's SSL | If selected, Connect will bypass the validation of your server's SSL
certificate certificate.

Select this option if your server's certificate is not valid, but you trust the
server.

4. In the Services section, click Packages: Settings.

The Packages dialog appears.
5. Modify the fields as needed:

Field

Description

Download received packages
to

Specify the folder where downloaded packages will be saved.

You can download packages to the default folder:, or you can click
Change to provide a different folder name.

Overwrite packages that have
the same title

When a received package has the same title as an existing package,
Connect can either reuse the same folder (overwriting the existing
package), or create a new folder for the received package.

If you select this check box, packages with the same name as an
already existing downloaded package will be downloaded into the
existing folder. If a file being downloaded has the same name as an
existing file, that file from the older package is overwritten.

If you do not select this check box, Connect will create a new folder
for the new package, so that the existing one is not overwritten.

For example, if you have already downloaded a package with a title
of My_Files, and then download another package with the same
title, the files will be placed in My_Files(2).

If you select this check box, Connect will place the new package
into the existing My_Files folder instead of creating a new
My_Files(2) folder. If My_Files already contains a file with the same
filename, the existing file will be overwritten.
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Field

Description

By default, this check box is not selected.

sent by me

Do not download packages If this check box is selected, packages that you send to yourself or

to work groups that you belong to are not downloaded.

If this check box is not selected, packages that you send to yourself
or to work groups that you belong to are downloaded. (By default, it
is not selected.)

from

configurable.

Note: This field is not

Packages are downloaded Displays the date since which Connect will search for packages to

download.

For example, if this field displays 05/06/2014, Connect downloads
any packages that have arrived since May 6, 2014.

Check for new packages Select the interval in which to check for newly arrived packages.

Automatically unlock
encrypted files on download | Connect to automatically decrypt them when they are downloaded.

If you have configured encryption for your packages, you can set

To do so, select this check-box and enter the decryption
passphrase in the Passphrase field.

6. Click OK to apply and save your settings, or click Cancel to cancel your selections.

Sending Faspex packages with Connect

To send packages to Faspex, you must first add a Faspex account to Connect. If you don't have a Faspex
account, you cannot access the Send Files dialog. For instruction on how to add a Faspex account, see
“Adding a Faspex account to Connect” on page 24.

1. Open the Send Files dialog:
a) If not already running, Launch Connect:

b) Right-click & > Send to....
2. In the Send Files dialog enter:

Field or Button Description

Account The account you will use to send the package from (required).

Email or Group The recipient of the package (required).

Title A short, relevant title for the package (required).

Notes A short message to the recipient of this package.

Files A list of the files and folders in the package that will be sent.

To add items to this list, click Add files or drag and drop from the into the
Send Files dialog.

Encrypt sent files Select this check box if you want to encrypt files before sending them. When
you select Encrypt sent files and click Send Package, you are prompted to
enter and confirm a passphrase.

When you send encrypted packages, you must provide the recipients with the
encryption passphrases so that they can decrypt packages after they receive
them.

Add files Click Add files to add a file or files to the package for transfer. You can also
drag and drop files from into this dialog.
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Field or Button Description

Add folder Click Add folder to add a folder to the package for transfer. You can also drag
and drop folders from into this dialog.

Remove To remove an item from the package to be sent, select it in the Files list and
click Remove.

3. Click Send to send the package.

The Connect Activity window's Transfers tab opens to display the progress of the transfer.

Receiving Faspex packages with Connect

Getting more Information about a transferred Package

1. Right-click & and select Activity.
2. Click Transfers to view a list of the recent packages that you have sent or downloaded.
3. With the buttons in the Transfers tab, you can:

©@ Opens the Transfer Monitor for more in-progress detail about the transfer.

In the Transfer Monitor, you can adjust the transfer rate (if settings allow).

Opens an window to the transfer destination folder (the "containing folder").
® Stops an in-progress transfer.
® Resumes a stopped or suspended transfer.

In addition to those actions, you can also right-click a package and select Remove to remove it from
the list.

Clearing a Transfer
If a transfer is not currently queued or running, you can remove it from the list:

On the Transfers tab, right-click a transfer in the list and select Remove.

Looking for New Packages

You can also do the following:

- To stop checking for packages, click @.

- To resume automatic checking for packages, click ®.
« To check for packages immediately, right-click an inbox and select Check now.

Decrypting Received Packages

If you receive an encrypted package, see “File encryption” on page 15.

Working with IBM Aspera Shares

IBM Aspera Shares is a multinode web transfer application that enables organizations to share content
with internal and external users.

Connect accounts that are set up with Shares as the transfer server provide the following functions:

« You can set up Connect to sync folders automatically on the client computer and on the server
whenever contents change. Content changes include
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— modification of file contents

— changes in file and folder names

— creation and deletion of files and folders

The sync feature can be configured to be one-way or bidirectional.

For detailed information on Shares, including system requirements and installation instructions, see the
IBM Aspera Shares documentation.

Adding a Shares account to Connect
Use the Connect account wizard to configure a new Shares transfer account.

To set up a transfer account, make sure you have the following information from the system administrator
who manages your Shares transfer server:

« A URL for the Shares transfer server, including a port and path (if applicable).
« A username and password that was set up on your Shares transfer server.
The steps below assume that you have Connect installed and running.

To add a Shares account to Connect:

1. Launch the Connect Preferences dialog and go to the Accounts tab.

2. Click [+]to add a Connect account.
3. Select your IBM Aspera product:
Click IBM Aspera Shares.
4. Fill in the fields with the following information about the Shares transfer server:

Account name A name for the account. The name is used only by Connect.

Server address The URL for the server that is running Shares.

5. If you are prompted to confirm the server's security certificate, indicate whether you trust the server.
6. Select your Shares server's authentication method:
Either
« SAML Authentication
If you choose SAML Authentication, log in to the Shares server with this user's SAML credentials.
or
« Basic Authentication

If you choose Basic Authentication, enter the username and password that this user has on the
Shares server.

7. If the transfer server supports synchronization, either
e Set up syncing now.

To do so, either accept the default folder shown for Place my files in the following directory, or
click Change to browse for a different folder (or create a new one).

By default, the sync folder is created inside your Documents folder, in a folder with the name
you gave for the account in an earlier step. If you choose to use the default folder, it is created
automatically.

or
« Set up syncing later.

To do so, click I'd rather not set up file syncing now.

8. If you opted to set up syncing on the previous screen, the Account Wizard prompts you to choose
folders to sync.
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You can either

« Select Synchronize with the selected remote folders and then select the folders on Aspera on
Cloud to sync.

Click the arrows to expand or collapse the folder view, and select the check boxes for the folders you
want to sync.

Choose the sync direction:
- Two-Way

— Remote to Local (default)
— Local to Remote

Note: For a detailed explanation of your options for sync direction, see “Synchronization” on page
29.

or

« Select I'll choose the folders to sync later.
9. When the screen displays a success message, click Finish to exit the Account Wizard.

Modifying a Connect Account for Shares

The steps below assume that you have Connect installed and running, and that you have created at least
one Connect account that you want to modify.

To modify a transfer account, do the following:

1. On the left side of the dialog, select the transfer server account you want to modify.
2. Under Account, you can change the connection settings for the account:

Field Description

Account name The name of the account. The name is used only by Connect.
Server address The URL for the server, and the port number (if applicable).
Username The username that you have on the transfer server.
Password The password that you have on the transfer server.

Do not verify host's SSL | If selected, Connect will bypass the validation of your server's SSL
certificate certificate.

Select this option if your server's certificate is not valid, but you trust the
server.

3. Back in the Preferences dialog, click Save to put into effect any changes you have made.

Synchronization

With Connect transfer accounts for IBM Aspera High-Speed Transfer Server, IBM Aspera on Cloud, and
IBM Aspera Shares, you can set up Connect to sync folders automatically on your client computer and the
server whenever the folder's content changes in either location.

Content changes include

« modification of file contents
- changes in file and folder names
« creation and deletion of files and folders
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Sync direction

When you set up sync, you must choose the direction of synchronization. Connect can be configured for
the following direction settings:

+ Remote to Local

This is the default setting. In this configuration, the remote computer (usually a server) retains the
master version of the files. The latest content is copied from the server to users' workstations.

« Local to Remote

In this configuration, the user's version of the content is assumed to be the master version, and is
copied to a central server. Typically, this setting is employed when users update content frequently.

« Two-Way

In a two-way, or bidirectional, sync relationship, changes in each location are copied to the other
location. With this type of sync, the contents of both remote and local are identical after the sync has
completed.

Note: When you have two-way sync configured, Connect runs these transfers using the lowest non-zero
bandwidth limit that you have set for automatic transfers. For details on setting bandwidth limits for
automatic transfers, see “Manual versus automatic transfers” on page 38.

If no bandwidth limit is set, Connect runs two-way sync transfers at the maximum rate that the server
and network conditions allow.

Avoiding Sync conflicts

To avoid unexpected results, understand what each sync direction setting means and choose carefully.
For example, consider the following scenario:

The system is configured for remote-to-local sync. When the scheduled automatic sync occurs, the latest
content is copied from the remote computer to the user's local desktop. A local user then creates a

new file. The next automatic sync occurs, but this new file still exists only on the user's computer. This

is the expected behavior in remote-to-local sync. In this scenario, the content on the destination is not
necessarily identical to that on the source.

Initial synchronization

When you first set up a sync relationship between two computers, the system performs its initial transfer
of content from the source location to the destination (or target) location. Depending on the size of the
content, this can be a large operation.

Then, when the system performs the next automatic sync, any changes at the source location are copied
to the target.

Automatic Sync versus Reset Sync
Automatic Sync

After the initial transfer, synchronization between the transfer server and client computers occurs
automatically, at the regular interval you have set in the Connect Preferences dialog.

In these automatic sync operations, the system transfers only the changes since the most recent sync.
Reset Sync

A reset operation is like starting over. Unlike automatic sync, a reset is a wholesale transfer of all the
content, not just the changed content. Because a reset clears the sync records, you typically perform a
reset only after resolving a conflict or changing the sync configuration.
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Use a signature file to prevent accidental directory deletion

Designate a file as the signature file (on either the local or remote storage, or both). Before starting the
sync, Connect verifies that the signature file exists. If the signature file cannot be found, Connect halts the
sync to prevent accidental deletion.

Configuring Sync in Connect

When you use Connect's synchronization capability, you can configure various aspects of the sync
relationship. Start by selecting Preferences > Accounts. Connect's synchronization works with IBM
Aspera High-Speed Transfer Server, IBM Aspera on Cloud, and IBM Aspera Shares.

In most cases, you set up sync folders when you added accounts to Connect. If you opted not to set up
sync with your accounts, or if you need to change the folders on the transfer server that you want the local
computer to sync with, follow these steps:
1. On the Accounts tab, select the account for which you want to configure sync folders.
2. In the Services area of the tab, click Sync: Settings.

The Sync Settings dialog appears.

Note: If sync capabilities are made available for the transfer server after the account has been added

to Connect, you must remove and then re-add the account to Connect in order to use the Sync
Settings dialog.

3. Select the folders on the remote server that you would like to sync with the local computer.

Browse through the nested folders shown under Synchronize with the selected remote folders, and
select the ones that should be synced with.

4. Set the local path for the sync.

Under Local Folder Path, the default path on the local computer is shown. If you want to change it,
click Browse and navigate to the desired location.

5. In the Direction drop-down list, choose Two-Way, Remote to Local, or Local to Remote.

Connect's synchronization between the remote server and the local computer can be upload-only,
download-only, or bidirectional. For a description of these sync direction options and their behavior,
see “Synchronization” on page 29.

6. Choose whether Connect should use continuous mode.

Connect usually checks for sync changes on an interval. When using continuous mode, Connect
detects new changes almost immediately.

7. Designate a file as the signature file on either the local or remote storage, or both. Set Local Mounts
Signature Pathname and Remote Mounts Signature Pathname.

Before starting the sync, Connect verifies that the signature file exists. If the signature file cannot be
found, Connect halts the sync to prevent accidental deletion.

8. Click OK to save.

Syncing content

Monitoring sync status
You can monitor the status of a sync operation on the Activity Window > Sync tab.

A progress bar shows in-progress synchronizations, and a countdown timer shows when the next
synchronization will take place.

Stopping and starting sync

You can stop and resume file syncing with these buttons on the Activity Window > Sync tab:
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® Stops an in-progress synchronization.

® Resumes a stopped synchronization.

Resolving sync conflicts

A sync conflict occurs when the file on one side does not match the file on the other side. Files and folders
may not be synchronized for reasons such as insufficient permissions for the destination folder on the
local computer.

If a file or folder cannot be synchronized, a conflict warning appears on the Activity Window > Sync tab.
To resolve the conflict, do the following;:

1. Click the red conflict link.

2. In the dialog that appears, select the file or folder that is in a conflict state.

3. Click Resolve Selected Conflicts.

Connect renames the content on the local file system, appending the phrase conflict-mine. For
example, the file log.txt is renamed as log.conflict-mine.txt.

Reset the sync

You can reset the sync at any time, such as after changing the sync configuration, or after resolving a sync
conflict. When you reset the sync, your sync configuration settings are retained, but the repositories are
rescanned for discrepancies. To reset the sync:
1. On the Accounts tab, select the account for which you want to configure sync folders.
2. In the Services area of the tab, open the Settings for the Sync service.

The Sync Settings dialog appears.

Note: If sync capabilities are made available for the transfer server after the account has been added

to Connect, you must remove and then re-add the account to Connect in order to use the Sync
Settings dialog.

3. Select Reset Sync and click OK.

Requirements for using Sync with Aspera on Cloud

If you are using Aspera Connect with Aspera on Cloud, Connect can synchronize files and folders
automatically between the remote server and the local computer.

Aspera on Cloud transfer service node does not support Sync

You cannot synchronize with an Aspera on Cloud folder if it resides on an AoCts (Aspera on Cloud transfer
service) node. For AoCts nodes, Sync is not supported. If you are not sure whether the node you plan to
use is an AoCts node, check with the AoC admin for your organization.

Shares user permissions

Shares users who will use Connect with sync features must be authorized to perform create, delete, and
rename file operations. The Shares admin can set these on the Authorizations tab.

Connect account configuration
You must have Connect accounts that can synchronize content with your Aspera on Cloud organization.

For more information, see “Adding an Aspera on Cloud account to Connect” on page 22.
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Sync configuration in Connect and in Aspera on Cloud

Pay close attention to the configuration of the sync relationship. In all cases, the settings in Aspera on
Cloud override the settings locally in Connect. Note that if your Aspera on Cloud transfer server nodes
are not correctly configured, you may experience sync problems between Aspera on Cloud and Connect
users.

For detailed information, see the IBM Aspera High-Speed Transfer Server documentation.

Requirements for using Sync with Aspera on Cloud

If you are using Aspera Connect with a Shares transfer server, Connect can synchronize files and folders
automatically between the remote server and the local computer.

Shares server configuration
In order to set up sync with a Shares server, the server must be configured for sync in its aspera.conf file
and must have the appropriate license.

For further information on your server's configuration file and license, see the Admin Guide for your
Shares transfer server.

Shares user permissions

Shares users who will use Connect with sync features must be authorized to perform create, delete, and
rename file operations. The Shares admin can set these on the Authorizations tab.

Connect account configuration
You must have Connect accounts that can synchronize content with a Shares server.

For more information, see “Adding a Shares account to Connect” on page 28.

Sync configuration in Connect and in Shares

Pay close attention to the configuration of the sync relationship. In all cases, the settings on the Shares
server override the settings locally in Connect. Note that if your Shares server is not correctly configured,
you may experience sync problems between the server and Connect users.

For detailed information, see the IBM Aspera High-Speed Transfer Server documentation.

Configuration

The Connect Preferences dialog allows you to configure logging behavior and various options for file
transfers, such as transfer queuing, file download location, and the allowed number of transfer retries.

Launch Connect and open the Preferences dialog:

If Connect is already running, go to System Tray > Right-click Aspera Connect > Preferences. If it is not
running, you can execute the application manually by running:

~/.aspera/connect/bin/asperaconnect &
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Activity

Unlock encrypted files

Open log Folder

Preferences...
Check for updates
Run diagnostic
About...

Quit

General configuration

To set your general preferences, launch the Connect Preferences dialog and go to the General tab.

Field Description

Default

Remove transfer list | Specify how to remove transfer sessions from the
items Activity window: manually, or automatically on successful
transfers.

Manually is selected by default.

Manually

Logging level Warning: Do not change this setting unless
requested by Aspera Technical Support. Enabling
Debug or Trace logging may impact performance.

Choose the level of information to be recorded in the
Connect logs. Options are:

« Info — Default. Displays general messages about
requests, ascp spawn options, and transfer status
changes.

« Debug - Verbose. Displays validation and FASP
management messages, and passes -D to ascp.

» Trace — Extra verbose. Passes -DD to ascp. Used only
for diagnosing problems.

Info

Disk space warning | Specify the disk space threshold for automatic transfers.
If the available disk space is less than the specified
threshold, a warning is displayed.

5 percent

Specify the 1000
maximum number
of files and folders
to display within a
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Field Description Default

folder in the remote
view.

Account configuration

To set your account preferences, launch the Connect Preferences dialog and go to the Accounts tab.

Adding an Account

« Forinstructions on adding Connect accounts for use with the Aspera on Cloud SaaS, see “Adding an
Aspera on Cloud account to Connect” on page 22.

« Forinstructions on adding Connect accounts for use with a Shares transfer server, see “Adding a Shares
account to Connect” on page 28.

« Forinstructions on adding Connect accounts for use with a Faspex transfer server, see “Adding a Faspex
account to Connect” on page 24.

Removing an Account

To remove an account, do the following:

1. In the list of accounts, select an account to be removed.
2. Click =) to remove the account.

When you remove an account, all account transfers and services associated with that account are
stopped and removed.

3. Click Yes to confirm the account removal, or click No to cancel the account removal.

Configuring Sync Settings

For Connect accounts that are set up with Aspera on Cloud or Shares as the transfer server, you can
configure synchronization settings, such as which remote folders to sync with, and the direction of the
synchronization relationship.

For instructions on using synchronization features, see “Syncing content” on page 31.

Configuring Package Settings
For Connect accounts that are set up with Aspera on Cloud or Faspex, you can configure the following:

« The local folder for received packages.
« Whether to overwrite packages.
« How often Connect should look for new packages.

For instructions, see “Modifying your package download settings” on page 25.

Transfer configuration

To set your transfer preferences, launch the Connect Preferences dialog and go to the Transfers tab.

Downloads

By default, Connect downloads files to the current user's Downloads folder. To change this setting, adjust
the following settings:

- Save downloaded files to — Specify the path to the location where downloaded files should be saved.
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- Always ask me where to save downloaded files — Choose this option to select a location for each

download.
Queue
Field Description Default
Setting
Enable queuing When this check box is selected, Connect limits the number of Selected
concurrent transfers.
Note: When transfers are queued, you can start them manually
from the Activity > Transfers window.
Maximum concurrent |If Enable queuing is selected, you can enter a maximum number |3
transfers of concurrent transfers in this field.
Any transfers above this value are queued and then started once
the number of concurrent transfers drops below the specified
value.
When queuing is not enabled, this field is not available.
Retry
Field Description Default
Setting
Automatically retry When this check box is selected, Connect retries failed transfers. | Selected
failed transfers If you want Connect to retry failed transfers, specify the number
of attempts and the interval in which Connect will try to resend in
seconds, minutes, or hours.
Attempts When Automatically retry failed transfers is selected, Connect |3
will make the number of retry attempts that you specify in this
field.
Interval When Automatically retry failed transfers is selected, Connect |30
will retry transfers at the interval you specify in this field. seconds
Multi-session

For information on configuring multi-session transfers, see “Multi-session transfers” on page 9.

size. This value is sometimes also referred to as the multi-session
threshold.

Field Description Default
Setting

Enable multi-session | Enable multi-session transfers. Unselected

Number of sessions The number of sessions you prefer (as guidance, not as a 3

requirement).

When transferring The transfer speed that triggers multi-session transfers. 700 Mbps

faster than

Split files larger than | Enable file splitting for files larger than or equal to the specified |60 MB
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Field Description Default
Setting
For example, using the default size value (60 MB), if the source
directory contains multiple files, all files less than 60 MB are
distributed between sessions, while all files 60 MB or larger
are split and then distributed between sessions. If the source
directory contains only one file and the file is 60 MB or larger, the
file is split, otherwise the file is transferred by one session.
Startup interval The amount of time to wait before the next session starts. 1 second
between sessions
Sync
Field Description Default
Setting
Interval If the sync feature is enabled, specify the interval between 30
synchronizations. seconds

Network configuration

To set your network preferences, launch the Connect Preferences dialog and go to the Network tab.

HTTP Proxy

HTTP fallback serves as a secondary transfer method when the Internet connectivity required for Aspera
accelerated transfers (UDP port 33001, by default) is unavailable. If UDP connectivity is lost or cannot be
established, if you have configured an HTTP proxy, the transfer continues over the HTTP protocol based

on this proxy configuration.

Although the HTTP proxy is used primarily for the HTTP fallback feature, it can be used for all HTTP-
related activities performed by Connect. However, it cannot be used for FASP transfers.

Field

Description

Use HTTP Proxy
» Username

- Password
« Address and Port

 your username
 your password
« your server's URL or IP address, and port number

Note: For some proxies, username and password are optional.

FASP Proxy

When IBM Aspera Proxy (a.k.a. FASP proxy) is enabled, Aspera passes the DNAT or DNATS (secure)
username, password, server address, and port to ascp.

Field

Description

Use FASP Proxy (DNAT)

If your transfers use an IBM Aspera FASP Proxy server, select this check
box.

Secure (DNATS)

Select this check box if your FASP Proxy uses a secure connection.

- Username
- Password
« Address and Port

Use these fields to define your FASP Proxy configuration. Type the
following information:

e your server username
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Field Description

« your server password
« your server's URL or IP address, and port number

Note: These fields are enabled only if Use FASP Proxy (DNAT) is
selected.

Bandwidth configuration

Transfer speeds depend on server settings and your network connectivity. To limit transfer rates, launch
the Connect Preferences dialog and go to the Bandwidth tab.

Manual versus automatic transfers

The limits you set on the Bandwidth tab can be different for transfers that are initiated manually
versus those that are automatically triggered. Automatic transfers can include sync-initiated transfers,
script-initiated transfers, or any other kind of background method of starting a Connect transfer.

Manual Transfers

Field Name Description

Downloads: Limit to When the Limit to check box is selected, you can set the download rate in
either megabits per second (Mbps) or kilobits per second (Kbps).

The limit you set here will apply to downloads that users initiate manually.

Uploads: Limit to When the Limit to check box is selected, you can set the upload rate in
either megabits per second (Mbps) or kilobits per second (Kbps).

The limit you set here will apply to uploads that users initiate manually.

Automatic Transfers

New limits to download and upload transfer rates immediately apply to non-continuous syncs. For new
limits to take effect on continuous syncs, you must stop and restart those syncs for the new limits to take
effect.

Field Name Description

Background downloads: When the Limit to check box is selected, you can set the download rate in
Limit to either megabits per second (Mbps) or kilobits per second (Kbps).

The limit you set here will apply to transfers that are initiated for Inbox
downloads or sync actions.

Background uploads: When the Limit to check box is selected, you can set the upload rate in
Limit to either megabits per second (Mbps) or kilobits per second (Kbps).

The limit you set here will apply to transfers that are initiated for sync
actions.

Security configuration

Connect security facilities allow you to specify restricted and trusted hosts, encrypt content, and manage
authentication credentials. To configure security, launch the Connect Preferences dialog and go to the
Security tab.

You can use these features to minimize security risks when uploading or downloading files:
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 You can add Aspera servers as Trusted Hosts to avoid the recurring security prompt, or add servers to
the Restricted Hosts list to require confirmation every time you attempt to initiate a transfer with that
host.

 You have the option of saving your authentication credentials when you connect to a server, as well as
removing them from the Passwords tab.

- Content protection is a feature that allows uploaded files to be encrypted during a transfer for the
purpose of protecting them while stored on a remote server. The uploader sets a password while
uploading the file, and the password is required to decrypt the protected file.

Managing hosts

When a transfer is initiated and the Remember my choice for this site option is enabled in the
confirmation dialog, the server you are allowing or denying is added to the Trusted Hosts or Restricted
Hosts list, respectively. To view, add or remove additional trusted hosts, go to Security > Trusted Hosts.
Enter the host's address in the specified text field and click Add.

Preferences - IBM Aspera Connect - 0O X

General S+ Accounts £2 Transfers #b Network > Bandwidth 1 Security

Trusted Hosts Restricted Hosts Passwords Content Protection

Trusted hosts are hosts to which you have granted permission to always allow transfers. If any
attempt is made to start a transfer with a host that is not on this list, you will be given the option
to allow or deny the transfer.

Address: Add

Host Remove
demo.asperasoft.com

Remaove All
faspex.com

To view, add or remove restricted hosts, go to Security > Restricted Hosts. Here, enter the host's address
in the specified text field and click Add.
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Preferences - IBM Aspera Connect - 0O X

General S+ Accounts £2 Transfers #b Network > Bandwidth 1 Security

Trusted Hosts Restricted Hosts Passwords Content Protection

Restricted hosts are hosts for which you have enabled enhanced security. If any attempt is made
to start a transfer with a host that is on this list, you will be presented with a warning before it
can proceed.

Address: Add

Host Remove

www.untrustedhost.com Remove All

Whenever you initiate a transfer to or from a host in the Restricted Hosts list or a host that's not in the
Trusted Hosts list, Connect displays a security warning asking whether you want to grant access to the
host for this transfer:

Managing passwords

To view or remove saved password information for a host, go to Security > Passwords. Here, you can
remove saved login credentials; however, you cannot add credentials to this list directly.

Preferences - IBM Aspera Connect - 0O X
General S+ Accounts £2 Transfers #b Network > Bandwidth 1 Security

Trusted Hosts Restricted Hosts | Passwords Content Protection
Login information has been saved for the following hosts:

Host User Remove

198.23.89.123 asperaweb
Remaove All

Whenever you attempt a transfer with a server where your credentials are not saved, you are prompted
with an authentication dialog and offered a Remember this password check-box. Marking the check-box
causes your login credentials to be saved and appear in the Passwords tab.
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Content protection

To specify hosts to which you want all uploads to be encrypted, open the Content Protection tab under
Security. In the Address field enter the Aspera server address and click Add. The server is then added to

the list.
Preferences - IBM Aspera Connect - 0O X
General S+ Accounts £2 Transfers #b Network > Bandwidth 1 Security

Trusted Hosts Restricted Hosts Passwords Content Protection

Content protection allows you to leave files encrypted on servers to which they have been
uploaded. Enter a list of hosts for which you want to enable this functionality.

Address: | Add

Host Remove

demo.asperasoft.com
P Remove All

When uploading files to a server on the list, or one that is configured as a content-protected host, you
are prompted for a passphrase to encrypt the files. You can also choose not to encrypt files if the server
allows it.

For details on encryption and decryption, see File Encryption.

Appendices

Configuring Faspex

To install and configure Faspex, follow the instructions in the IBM Aspera Faspex Admin Guide.

Note: Connect does not currently support adding metadata to packages that it sends. Therefore, ensure
that Faspex is not configured to have any required metadata fields when sending packages. You can
configure optional metadata fields, but Connect will ignore them.

Configuring Shares
Before configuring Shares to work with Connect, you need the following:

« A computer running the correct version of Shares and Enterprise Server.
« On each node on the Shares server, a supported version of Connect Server with a Connect-enabled
license.

Note: If you will use the synchronization feature, you must ensure that the Enterprise Server is configured
to use token authentication.

1. Log in to your Shares server as administrator, and go to Admin > Accounts > Users.

2. For each Shares user account that will use Connect, click Edit.

3. On the Security tab, ensure that the API Login check box is selected.

On Shares 1.6 and later versions, this permission is enabled by default whenever new users are
created.
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4. Create shares, and authorize users for each share.

For detailed instructions on creating shares and authorizing users, see the IBM Aspera Shares
Administrator Guide.

5. For each authorized user of a share, enable the following permissions to allow users to view, edit, or
delete files and folders when using Connect:

In Order to Allow This Action on ...Enable This Check Box on Shares
Connect...
View browse
download
Edit upload
mkdir
rename
Delete delete

6. For each Shares user account that will use Connect, repeat these steps.

For more information on Shares, see the Shares Administrator Guide.

Log Files

You can access Connect log files from within Connect or from your file system.

Log Files

aspera-connect.log
log file for the Connect application

aspera-scp-transfer.log
log file for the ascp transfers

nativemessagehost.log
log file for host messages

Log File Location

Log files are located in the following location:

~/.aspera/connect/var/log/
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Activity

Unlock encrypted files

Open log folder

3

Preferences...

About...

Quit

Deploying Connect Extensions in Closed Environments

Locked-down or enterprise environments without access to the public internet generally require special
steps to acquire and enable Connect web extensions. Depending on OS platform and browser, there are a
number of methods for doing so.

Chrome
Method: Manual deployment Using Drag and Drop

1. Download the Connect extension CRX file from Google. To do so, right-click this link and select Save
Link As: Connect extension for Chrome

2. Openchrome://extensions
3. Enable developer mode.
4. Drag-and-drop the CRX file into the chrome: //extensions window to install.

Firefox
Method: Manual deployment

1. Download the Connect extension XPI file from Mozilla. To do so, right-click this link and select Save
Link As: Connect extension for Mozilla

2. Open about:addons
3. From the menu, select Install Add-on From File.

Method: Deploying Aspera Connect add-on with custom build of Firefox

See Mozilla documentation:

https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Distribution_options/Add-
ons_in_the_enterprise#Bundling_add-ons_with_a_custom_Firefox

Allowlisting the Chrome Extension

By default, all Chrome extensions are allowlisted (a.k.a. whitelisted). However, if your organization
blocklists all extensions by policy, you can override the blocklist and allow the Connect extension to
be installed by adding it to the allowlist.

https://www.chromium.org/administrators/policy-list-3#ExtensionInstalliWhitelist
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The instructional links below also include information on other extension-related policy settings that
enable you to automatically install Chrome, force-install Chrome, and so on.

Note: These policies are intended strictly for configuring instances of Google Chrome internal to your
organization. Use of these policies outside of your organization (for example, in a publicly distributed
program) is considered malware and will likely be labeled as malware by Google and anti-virus vendors.

Provisioning Policy Using Chrome Policy Templates

1. Install Chrome policy templates: Detailed instructions can be found here:

https://support.google.com/chrome/a/answer/187202?hl=en

2. Set Chrome extension policies. Detailed instructions can be found here:

https://support.google.com/chrome/a/answer/7517525

a. Create a file with the following contents in /etc/opt/chrome/policies/managed/
test_policy.json:

"ExtensionInstallWhitelist": ["kpoecbkildamnnchnlgoboipnblgikpn"]

b. Restart Chrome.

c. To verify that the policy has been applied, enter the following in the address bar:

chrome://policy

Troubleshooting

Disabling SELinux

SELinux (Security-Enhanced Linux), an access-control implementation, can prevent web UI access.
To disable SELinux:

1. Open the SELinux configuration file: /etc/selinux/config.
2. Locate the following line:

SELINUX=enforcing
3. Change the value to disabled:

SELINUX=disabled

Save your changes and close the file.

4. On the next reboot, SELinux is permanently disabled. To dynamically disable it before the reboot, run
the following command:

# setenforce 0O

Disabling AppArmor

AppArmor is a Linux security module that uses mandatory access control (MAC) to restrict some
applications' system access. It may prevent Connect from running correctly on some Linux systems.

To disable AppArmor, enter the following commands on the affected computer:

# /etc/init.d/apparmor stop
# update-rc.d -f apparmor remove
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Connectivity issues

SSH connectivity errors: "Timeout establishing connection"

If you receive the error "Timeout establishing connection," the TCP connection between Connect and the
server is blocked (error codes 13, 15, or 40 in the log files). To determine the cause, open a Terminal or a
Command prompt on the client machine (where Connect is installed). Use telnet to test the connection
to the server:

telnet server-ip-address 33001

where server-ip-address is the IP address of the Aspera server (ex. 10.0.1.1) on TCP port 33001 (or the
configured TCP port, if other than 33001).

You will receive one of the following errors and can take the appropriate action:

« "Connection refused": The Aspera server is not running the SSHD service. Have your server
administrator review the server's SSH service status.

« "Timeout": The client-side firewall is disallowing outbound TCP traffic. Ensure that the client-side
firewall allows outbound TCP traffic on port 33001 (or the configured TCP port).

UDP connectivity errors: "Data transfer timeout"
If Connect appears to successfully connect to the server but:

« The transfer progress reads 0%.
- Files appear to be transferred to the destination but are 0 bytes.
« You eventually receive the error "Data transfer timeout."

UDP connectivity is blocked, likely by the firewall configuration (error codes 14, 15, and 18 in the log
files). Ensure that the client-side firewall allows outbound traffic on the FASP UDP port (33001, by
default) and the server firewall allows inbound traffic on UDP port 33001.

IBM Aspera Connect diagnostic tool

Aspera provides a web-based diagnostic tool that can be useful for identifying connection issues. You can
access the tool here:

https://test-connect.asperasoft.com/

Transfer issues

Connect won't transfer .partial files

With the default configuration for Connect, if you try to transfer files that have a . partial extension,
you'll notice these files are skipped. This is because the . partial extension has special meaning for
Connect. For afile in transit, . partial is the default temporary extension for the partial file on the
receiving end before its transfer is complete. When the file's transfer is finished, the extension is removed.

You can transfer the skipped files by changing the name of the filename extension that Connect uses.
Choose a name that you don't expect will be used by files you transfer.

To make this change:

1. Locate the Connect aspera.conf file on the machine at the receiving end of the transfer. The
aspera.conf file is included in the Connect installation. Open it with a text editor:

~/ .aspera/connect/etc/aspera.conf
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2. Go to the line that begins with <partial_file_suffix>, and change .partial to a name your
transfer files will not be using:

<?xml version='1.0"' encoding='UTF-8'?>
<CONF version="2">

<default>
<file_system>
<storage_rc>
<adaptive>
true
</adaptive>
</storage_rc>
<resume_suffix>.aspera-ckpt</resume_suffix>
<partial_file_suffix>.partial</partial_file_suffix>
<replace_illegal_chars>_</replace_illegal_chars>
</file_system>
</default>

</CONF>

Note: Removing the <partial_file_suffix> entry or setting it to a null value will not necessarily
solve the problem. Doing so means the file extension used for partial files becomes whatever is set in
the aspera.conf for ascp, which by default is . partial.

3. Save your changes to the Connect aspera. conf file. The changes will take effect with the next
transfer.
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